


Računalstvo
Obrada teksta - MS Word
1. Obrada teksta u Microsoft Wordu – osnovni pojmovi

1.1. Uvod u obradu teksta
-obrada teksta omogućena je pojavom programa koje zovemo obrađivači teksta (tekstni procesori, engl. text processor)
-najčešće za to koristimo program Microsoft Word, kraće – MS Word ili samo – Word
-on je dio programskog paketa Microsoft Office  - kraće MS Office ili samo – Office
-ovdje obrađujemo Word 2019 iz paketa Office 2019
-Word služi za složeniji rad s tekstom i ostalim objektima (obrada teksta, engl. text processing) dok za jednostavne preinake na čistom tekstu služe uređivači teksta (editori teksta, engl. text editor, npr. Blok za pisanje)
-sadržaj stvoren u Wordu možemo spremiti u više raznih vrsta datoteka, a takvu datoteku zovemo dokumentom (engl. document)
-sufiksi tih datoteka su:
· [image: ]docx
-ovo je dokument spremljen u uobičajenom obliku
-on podržava sve naredbe i objekte dostupne u Wordu
[image: ]-ako ništa ne želimo mijenjati, Word automatski sprema sadržaj u taj format
· doc
-to je dokument spremljen u starijim verzijama Worda, do verzije 2003
-stariji format dokumenta ne podržava direktno (radi se pretvorba) sve naredbe i objekte dostupne u Wordu pa program često pri spremanju iz novoga u stari oblik dokumenta traži pristanak korisnika za potrebne pretvorbe
-neki složeniji objekti ne mogu se spremiti iz novijega formata u stari
-koristimo ga ukoliko netko nema noviju verziju Worda ili ne želimo promijeniti izgled dokumenta spremljenog u starom formatu datoteke
-ukoliko otvaramo stariji format, Word traži da kliknemo gumb koji će omogućiti preinake u tekstu
· pdf
-u nekoliko zadnjih verzija podržano je spremanje u ovaj univerzalni format za razmjenu datoteka
-pretvaranje u ovaj oblik koristimo ako želimo poslati nekome dokument, a on ne koristi Word ili prije ispisa na većim formatima (npr. želimo ispisati plakat formata A1)
-možemo i otvoriti postojeću PDF datoteku za uređivanje sadržaja, ali pritom ju najprije moramo pretvoriti u docx format
-pri takvom pretvaranju često se dogodi da Word ne zna ispravno prepoznati složeniji dio sadržaja (npr. tablice ili crteže) pa te dijelove pretvori u sliku čiji sadržaj ne možemo uređivati
-u tom slučaju neprepoznate dijelove datoteke moramo ručno unijeti
· xml
-ovo je format u obliku web stanice
-rijetko ga upotrebljavamo, osim za dodavanje sadržaja na web stranice
· txt
-ovakav oblik datoteke zadržava samo tekst bez opcija oblikovanja (npr. podebljanje, boja fonta, efekti teksta)
-taj oblik identičan je onome Bloka za pisanje
-koristimo ga ponekad ako nam je bitan samo sadržaj (npr. serijski brojevi računalne opreme)
-programi za obradu teksta namijenjeni su za: 
· uređivanje teksta i ostalih sadržaja
· oblikovanje teksta i ostalih sadržaja
· ispisivanje teksta i ostalih sadržaja
-omogućavaju brzo i lako pisanje teksta, ispravljanje, oblikovanje, pretraživanje, ispis, umnožavanje, unos slika, organiziranje podataka u tablice te još puno toga 
-svaku datoteku koju stvorimo Wordom nazivamo dokumentom
-dokument se sastoji od niza stranica (engl. page) koje se (za razliku od onih u knjigama) tipično nalaze jedna ispod druge, a ne jedna pokraj druge
-rubovi stranica dokumenata zovu se margine (engl. margin) i ne služe za upis teksta, već dodatnog sadržaja (npr. broja stranice, engl. page number)
-osnovni dio teksta u dokumentu zovemo odlomak (engl. paragraph), a prepoznajemo ga po tome što završava (i počinje) pritiskom na tipku Enter (krajevi odlomka su i početak i kraj dokumenta)
-odlomak u Wordu odgovara po smislu odlomku u knjizi
-pismom (engl. font) nazivamo određenu vrstu izgleda znakova koje koristimo u dokumentu
-fontovi su definirani vrstom (tipom), veličinom, bojom i posebnim svojstvima (npr. podebljanjem)
-pokazivač (kursor, engl. cursor) je trepćuća crtica koja pokazuje trenutno mjesto upisa teksta
-ukoliko je redak teksta dulji od širine radnog područja, program će ga automatski prebaciti u novi red, čim tekst dotakne desni rub radnog područja
-program Word pokrećemo:
· dvoklikom ikone programa (uobičajeno)
· dvoklikom na neku njegovu datoteku
· odabirom imena programa iz popisa instaliranih programa
-trenutno otvoreni dokument u Wordu se zatvara odabirom naredbe Datoteka>Zatvori (engl. File>Close) ili klikom na gumb prozora za zatvaranje (bijeli x u crvenom kvadratiću)
1.2. Opis prozora u programu
-tipičan izgled prozora u Wordu 2019 prikazan je idućom slikom
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-prozor Worda sastoji se od ovih dijelova:
1. vrpce s naslovom (naslovne trake, engl. Title bar)
-na njoj piše naziv programa s kojim radimo (Word) i naziv datoteke u kojoj trenutno radimo
-osim toga, na kraju vrpce se nalaze gumbi za minimiziranje, sažimanje (ili maksimiziranje) i zatvaranje programa
-ukoliko datoteci nismo dodijelili neko ime, Word joj automatski daje naziv Dokumentn, gdje je n broj nespremljenog dokumenta (npr. Dokument1, Dokument2, ...)
2. alatne trake za brzi pristup (engl. Quick Access Toolbar)
-ovdje se nalazi nekoliko često korištenih naredbi (npr. Spremi, Poništi upis, Ponovi upis)
[image: ]-na tu traku možemo dodati još više naredbi ili maknuti postojeće (klikom na krajnje desni simbol trokutića) 
-nije preporučljivo prepuniti traku jer postaje nepregledna i time manje upotrebljiva
3. vrpca (engl. Ribbon) s karticama i naredbama za rad u dokumentu
-to su vrpce koje u sebi sadrže ikone nekih od često korištenih naredbi
-postavi li se pokazivač miša iznad neke od ikona u vrpci, pojavi se okvirić s kratkim opisom naredbe koju ta ikona predstavlja
-sadržaj vrpce vidi se odabirom odgovarajuće kartice (npr. Polazno)
4. kartica (engl. Tabs)
-tu se nalaze gumbi grupa naredbi (npr. Dizajn, Raspored) iz kojih možemo odabrati željene naredbe pomoću lijeve tipke miša ili pritiskom na tipku Alt i izborom slova u okviriću oko gumba (npr. tipka Alt i slovo D otvaraju karticu Datoteka)
5. grupa naredbi (engl. Group)
-to je naziv za više češće korištenih naredbi na otvorenoj vrpci, a grupiranih po nekom kriteriju sličnosti (npr. u grupi Font su prikazane ikone nekih češćih naredbi za promjenu izgleda pisma)
6. pokretača dijaloškog okvira (engl. Dialog Box Launcher)
[image: ]-klikom na sitni kvadratić sa strelicom otvara se prozor sa svim dostupnim naredbama u nekoj grupi naredbi (npr. klikom na taj kvadratić pokraj grupe Odlomak otvara se prozor sa svim naredbama kojima možemo oblikovati odlomak) 
7. ravnala (engl. Ruler) po horizontali i vertikali
-ravnala nam prikazuju udaljenost od početka stranice (gornji lijevi kut prozora) u cm ili mm te nam omogućuju orijentaciju na stranici (odnose veličina pojedinih dijelova stranice)
[image: ]-na horizontalnom ravnalu možemo namještati oznake za uvlačenje teksta (bitno za oblikovanje odlomaka na stranici)
-bijeli dio ravnala označava mjere na radnoj površini, a sivi na marginama 
8. radne površine (plohe, područja, engl. Workspace)
-to je najveći dio prozora Worda, a služi nam za unos i obradu nekog sadržaja (većinom teksta) u dokumentu
-možemo birati različite načine prikaza u tom području
9. gumbi za promjenu prikaza dokumenta (engl. View Buttons)
-njima možemo brzo promijeniti prikaz dokumenta
-na raspolaganju su nam Raspored za ispis, Način za čitanje, Raspored za web
-uobičajeno koristimo Raspored za ispis (izgled na ekranu jednak je ispisanom)
-Način za čitanje ubrzava i olakšava čitanje, dok je Raspored za web pogodan za prikaz web sadržaja
10. vrpce stanja ili statusne trake (engl. Status bar)
-na njoj se pojavljuju poruke o stanju programa (npr. Word je pronašao jezične pogreške) i informacije o trenutnoj stranici, ukupnom broju stranica i jeziku postavljenom u Wordu za jezičnu provjeru i provjeru pravopisa
11. klizača (engl. Scroll bar, Slider) po horizontali i vertikali
-njima se cijeli sadržaj radnog područja pomiče za željeni iznos gore-dolje ili lijevo-desno
-sadržaj pomičemo s ciljem lakšeg nalaženja traženog dijela dokumenta
[image: ]-kliknuti lijevom tipkom miša možemo na strelice na krajevima klizača, između klizača i strelica na krajevima ili na klizač koji povlačimo u željenom smjeru
-pomicanje na klik je:
· red gore-dolje (klikom na strelicu)
· ekran gore-dolje (klikom između klizača i strelice) 
· više stranica gore-dolje (pomicanjem klizača)
-slično, na horizontalnom ravnalu klikanjem se pomičemo više ili manje znakova ulijevo-udesno
-ovisno o količini sadržaja i načinu prikaza vidimo jedno ili oba ravnala
12. gumba zumiranja (engl. Zoom)
-pomicanjem klizača ili klikanjem na + ili - biramo brzo veličinu prikaza dokumenta u opsegu od 10 % (10 puta smanjeni prikaz strane, vidi se puno sitnih strana dokumenta) do 500 % (5 puta uvećani prikaz stranice dokumenta, vide se samo pojedina slova ili riječi)
-iznos zumiranja piše u okviriću desno od znaka +, a klikom iznosa zuma otvaramo dijaloški okvir u kojem možemo dodatno podešavati veličinu prikaza (npr. Širina stranice) 
1.3. Kartice (engl. Tabs) u Wordu
-sve naredbe Worda grupirane su u kartice (prije su se slični gumbi zvali izbornici ili meniji (engl. menu)
-otvaranjem neke kartice vidljive su na horizontalnoj traci grupirane (engl. group) neke od češće korištenih naredbi  (i neke dodatne mogućnosti naredbi)  prikazane ikonama
[image: ][image: ]-to nisu sve dostupne naredbe, ali klikom na pojedine dostupne pokretače dijaloških okvira otvaraju se sve dostupne naredbe
-u Wordu postoje ove osnovne kartice:
a) Datoteka (engl. File) 
-njezine naredbe služe za rukovanje datotekama (npr. otvaranje, stvaranje, spremanje), za postavljanje dodatnih mogućnosti programa (npr. zadane lokacije za smještanje dokumenata) i za ispis dokumenta
-odabirom te kartice prikazuju se naredbe u vertikalnom smjeru
b) Polazno (engl. Home)
[image: ]
-ovdje su naredbe kojima se rade preinake u tekstu (npr. brisanje, kopiranje, traženje teksta i sl.) i oblikuju odlomci
-naredbe su svrstane u ove grupe:
· Međuspremnik (engl. Clipboard)
-služi za privremeno pamćenje do 24 kopirane ili izrezane stavke (npr. teksta)
· Font (engl. Font)
-tu mijenjamo osobine pisma (npr. vrsta i veličina pisma)
· Odlomak (engl. Paragraph)
-ovdje su naredbe za oblikovanje odlomka (npr. poravnanje, prored)
· Stilovi (engl. Styles)
-namijenjen je za stvaranje i odabir stilova
· Uređivanje (engl. Editing)
-tu je nekoliko naredbi za uređivanje teksta (npr. traženje, zamjena)
c) Umetanje (engl. Insert)
[image: ]
-kao što sugerira naziv kartice, nekom od ovih naredbi može se u dokument ubaciti neki objekt (npr. slika, posebni znak i sl.)
-sastoji se do ovih grupa naredbi:
· Stranice (engl. Pages)
-ovdje umećemo praznu ili naslovnu stranicu, odnosno kraj stranice
· Tablice (engl. Tables)
-tu su sve naredbe za rad s tablicama (npr. Umetni tablicu)
· Ilustracije (engl. Illustrations)
-služi za umetanje grafičkih objekata (npr. slika i crteža)
· Dodaci (engl. Add-ins)
-ovdje možemo instalirati i koristiti neki program kojim dopunjujemo ili poboljšavamo rad Worda (npr. tipkovnicu s emojima)
· Medijski sadržaji (engl. Media)
-koristimo ga za ubacivanje video i zvučnih zapisa (npr. s Youtubea)
· Veze (engl. Links)
-dodajemo linkove i sl. (npr. link na web stranicu Net.hr)
· Komentari (engl. Comments)
-ovim naredbama možemo dodati i uređivati komentare
· Zaglavlje i podnožje (engl. Header & Footer)
-kada nam treba dodati broj stranice i sl. u podnožje ili zaglavlje stranice, biramo ove naredbe
· Tekst (engl. Text)
-želimo li na stranicu dodati posebne tekstne oblike (npr. tekstni okvir), ovo je pravo mjesto za to
· Simboli (engl. Symbols)
-ustrebaju li nam znakovi kojih nema na tipkovnici ili neka formula, odabiremo naredbe iz ove grupe
d) Dizajn (engl. Design)
[image: ]
-ovim naredbama možemo dodatno poboljšati izgled dokumenta (npr. dodavanjem i podešavanjem efekata teksta)
-kartica je podijeljena na:
· Oblikovanje dokumenta (engl. Document Formatting)
-ovdje možemo promijeniti izgled teksta promjenom svojstava pisma ili odabirom drukčijeg stila ili teme (npr. odaberemo temu Faseta)
· Pozadina stranice (engl. Page Background)
-ne želimo li bijelu pozadinu stranice, ovdje ju možemo uokviriti i postaviti nove pozadine (npr. sliku cvijeta kao pozadinu)
e) Raspored (engl. Layout)
[image: ]
-time utječemo na izgled stranice i odnose pojedinih elemenata na njoj (npr. stranica A3 gdje jedna slika djelomično prekriva drugu)
-tri su grupe naredbi:
· Postavljanje stranice (engl. Page Setup)
· Odlomak (engl. Paragraph)
· Rasporedi (engl. Layouts)
-ovdje definiramo odnose objekata (npr. prelamanje teksta)
f) Reference (engl. References)
[image: ]
-ove naredbe pomažu nam snalaženju u dokumentu (npr. umetanjem tablice sadržaja, fusnota, popisa slika,…)
-ima dosta grupa naredbi, ali se rijetko koriste na manjim dokumentima
g) Skupna (cirkularna) pisma (engl. Mailings)
[image: ]
-ovim naredbama stvaramo pisma koja treba slati na puno adresa pri čemu je većina sadržaja ista, a neki dijelovi su individualni (npr. u pismu o promjeni uvjeta neke banke za kredite je sadržaj pisma isti, a mijenja se samo adresa na koju se pisma šalju)
h) Pregled (engl. Review)
[image: ]
-ovim naredbama koristimo se kada radimo provjeru gotovoga dokumenta (npr. provjeravamo da li postoje pravopisne pogreške)
-naredbe su uglavnom namijenjene kada skupina osoba zajedno radi na istom dokumentu (npr. pišu udžbenik iz Računalstva)
i) Prikaz (engl. View)
[image: ]
-tu su naredbe za upravljanje prikazom sadržaja i prozora dokumenta
-glavne grupe naredbi su:
· Prikazi (engl. Views)
-ovdje biramo način prikaza dokumenta (npr. većinom koristimo Raspored za ispis)
· Pokaži (engl. Show)
-prikazujemo ili skrivamo dodatne elemente (npr. ravnalo, crte rešetke i navigacijsko okno)
· Zumiraj (engl. Zoom)
-ovime određujemo veličinu prikaza (npr. Širina stranice)
· Prozor (engl. Window)
-kada istodobno radimo s više dokumenata (npr. kopiramo iz jednoga u drugi), možemo si ubrzati rad tako da svaki otvorimo u zasebnom prozoru
j) Pomoć (engl. Help)
[image: ]
-kao što nam sugerira naziv, u ovom izborniku nalaze se naredbe za traženje pomoći kod rada s programom
-ovisno o tome s kakvim objektom radimo, otvaraju se kartice dodatnih alata (npr. kada radimo na tablici ili na slici)
1.4. Rad s datotekama 
-stvaranje novog praznog dokumenta najlakše je naredbom Datoteka>Novo (engl. File>New), klikom na ikonu u traci za brzo pokretanje ili prečicom Alt + N (skraćeno od engl. New)
[image: ]-nakon aktiviranja te radnje (bilo kojim načinom) pojavljuje se okno zadataka (mali prozor s desne strane unutar glavnog prozora za pisanje teksta) te nam nudi stvaranje praznog dokumenta ili biranje određenog predloška (engl. template)
-predložak je dokument oblikovan na određeni način tako da su neki elementi već raspoređeni pa ga možemo samo doraditi (npr. predložak za rođendansku čestitku)
-predlošci u Wordu slični su onima koje uobičajeno koristimo u Powerpointu 
-predložak je smisleno koristiti ako manjim njegovim izmjenama dobivamo očekivani izgled dokumenta
-u Wordu je puno dostupnih predložaka raspoređenih u grupe na temelju tematske povezanosti (npr. Letak pozivnice na zabavu), a još više ih možemo pronaći na internetu (npr. na stranicama proizvođača Officea, Microsofta)
[image: ]-bilo koji Wordov dokument možemo koristiti kao predložak za buduće dokumente
-u tom slučaju ne spremamo ga kao klasični Wordov dokument (sufiks .docx) nego kao datoteku predloška (nastavak .dotx)
-uobičajeno ne koristimo predloške nego stvaramo prazan dokument (engl. blank document)
-Word automatski praznoj datoteci daje ime Dokument1 (ako je to prva prazna datoteka) ili isti naziv uz neki drugi redni broj (npr. Dokument4)
[image: ]-poželjno je da se datoteci promijeni ime u neko smisleno, tj. napravi se kopija datoteke kojoj se dodijeli neko željeno ime
[image: ]-u tu svrhu dokument se sprema na izabrano mjesto naredbama Datoteka>Spremi kao (engl. File>Save As)
-pojavit će se prozor Spremi kao (engl. Save as)
-možemo birati spremanje (uz izbor novoga imena datoteke) na računalu (opcije Ovo računalo ili Pregledaj) ili na nekoj web usluzi spremanja  u oblaku (npr. OneDrive)
-možemo pogledati i popis nedavno otvaranih datoteka (Nedavno, engl. Recent) i mapa za smještanje
-mape za smještaj datoteka koje često koristimo možemo jednostavno kliknuti mišem i time ih staviti na traku za brzo pokretanje Explorera datoteka
-u prikazu nalik na ono Explorera za datoteke izaberemo disk i mapu (kliknemo lijevom tipku na njezino ime) u koju ćemo spremiti datoteku
-pritom u polje Naziv datoteke (engl. File name) unosimo naziv datoteke (neko smisleno ime), dok sufiks definira polje Spremi u obliku (engl. Save as)
-uobičajeno je da u tom polju stoji naziv Word Document što označava da je sufiks datoteke .docx
-može se izabrati i neka druga vrsta formata (npr. txt, doc, pdf, dotx), ali to je uglavnom za neke posebne namjene (npr. spremanje za stariju verziju Worda)
-nakon toga se svako daljnje spremanje bez promjene datoteke obavlja naredbom Spremi (engl. Save) koju možemo pokrenuti iz vrpce (Datoteka>Spremi (engl. File>Save)) ili kliknuti na ikonu na traci za brzo pokretanje
-Word sam automatski sprema sadržaj nakon određenog vremena (obično je to 5 minuta), ako je tako podešeno u opcijama programa
-ponekad je vrlo nezgodno tako često spremanje sadržaja (pogotovo radimo li s velikim datotekama, npr. datoteka s velikim slikama) pa se ta opcija može isključiti te se spremanje obavlja ručno
-u tom slučaju poželjno je spremanje barem svakih 15 minuta da ne bi došlo do gubitka svega unesenoga u datoteku nakon zadnjeg spremanja sadržaja (npr. zbog neispravnog rada Worda ili Windowsa – blokiranja programa)
-u Wordu je čest slučaj da istodobno imamo otvoreno nekoliko dokumenata (npr. iz jedne datoteke kopiramo dio teksta u drugu)
[image: ]-promjenu trenutno otvorene datoteke (aktivne) vršimo najjednostavnije klikom lijevom tipkom na ikonu programa i odabirom željene datoteke u vrpci zadataka
-trenutno prikazana otvorena datoteka prikazana je u tamnijem okviru 
[image: ]-manje efikasan (i rijetko korišten) način za promjenu trenutno prikazane otvorene datoteke je pomoću kartice Prikaz na kojoj odabiremo naredbu Promjena prozora 
-sve datoteke koje su otvorene prikazane su na popisu, a ona koja je aktivna (prikazana) označena je kvačicom
-aktivnu datoteku mijenjamo lijevim klikom na ime datoteke, a pritom se kvačica premjesti uz ime te datoteke
-datoteku uobičajeno zatvaramo naredbom Datoteka>Zatvori (engl. File>Close) ili prečicom Ctrl + W
-ukoliko prije toga nismo spremili zadnju promjenu u datoteci, Word nas pita želimo li to učiniti ili ne
-datoteku u općem slučaju otvaramo naredbom Datoteka>Otvori (engl. File>Open), prečicom Ctrl + O (od engl. Open) ili klikom na neku Wordovu datoteku ako Word nije pokrenut
[image: ]
-poslije toga otvara se prozor identičan onom naredbe Spremi kao s popisom diskova, mapa i datoteka iz kojeg biramo datoteku u nekoj od mapa te kliknemo lijevom tipkom miša na gumb Otvori (engl. Open) 
-datoteke koje su bile posljednje otvorene stavljene su na spisak prve
-na dnu popisa mapa nalazi se gumb Oporavi dokumente koji nisu spremljeni (engl. Recovery unsaved documents)
-ta naredba je korisna ako je došlo do prestanka rada Worda, a nismo spremili sve promjene
-čak i u slučaju rušenja, Word često uspije spremiti promjene, ali datoteka nema ispravni naziv
-tada ovom naredbom vraćamo takvu datoteku u željeno stanje
-u kartici Datoteka još postoje naredbe:
a) Informacije (engl. Info)
-ovom naredbom dobijemo detaljne podatke o dokumentu i njegovu statistiku (npr. kako dugo je rađeno na njemu, koliko je u njemu stranica i znakova i sl.)
-možemo kliknuti i jedan od tri gumba:
· Zaštiti dokument (engl. Protect Document)
-ovdje zadajemo kakva prava na izmjene u dokumentu ima netko kome pošaljemo datoteku
-uobičajeno ima sve ovlasti, ali možemo ih i ograničiti  (npr. da može samo čitati i ispisivati, a ne i mijenjati sadržaj ili oblikovanja)
-da netko nepozvan ne bi znao sadržaj datoteke, ovdje ju možemo zaštiti i lozinkom koju će onda trebati unijeti za svako otvaranje datoteke
· Provjeri ima li problema (engl. Check for Issues)
-ovom naredbom provjeravamo da li:
· su u dokumentu vidljivi neki osobni podaci (npr. da li se vidi ime autora dokumenta)
· osobe s poteškoćama imaju problema pri pregledavanju sadržaja (npr. da li ga lako može koristiti slabovidna osoba)
· je dokument kompatibilan s nekim starijim verzijama (npr. da li će se pri spremanju u neku verziju izgubiti dio sadržaja)
· Upravljanje dokumentom (engl. Manage Document)
-ovdje možemo vidjeti popis dokumenata koje smo zatvorili bez spremanja i probati vratiti njihov sadržaj (ako je to potrebno)
[image: ]
b) Ispis (engl. Print)
-ovdje otvaramo prozor za podešavanje ispisa dokumenta
-u njemu možemo vidjeti kako izgleda sadržaj koji ćemo ispisivati i zumirati ga
[image: ]
-za ispis zadajemo:
· postavke ispisa
-ovdje biramo:
· vrstu pisača (ako ga ne biramo, koristi se unaprijed zadani pisač u Windowsima) i njegova svojstva (npr. kakva je kvaliteta ispisa i kakav medij se koristi za ispis, npr. prozirna folija za laserski pisač)
· broj kopija
· raspon ispisa dokumenta:
· cijeli dokument
· samo neke stranice (prilagođeni ispis)
-pojedine stranice odvajamo zarezom, a ako je neprekinuti raspon znakom –
-primjer ispisa stranica: 1,4,5-7,9-11 //ispisujemo stranice 1,4,5,6,7,9,10,11
· trenutnu stranicu (to je stranica na kojoj nam se nalazi kursor)
· odabrane sadržaje (samo ono što smo označili u dokumentu)
· načine dovršavanja ispisa:
· jednostrani ili dvostrani ispis (ovisno da li pisač podržava dvostrani ispis)
· redoslijed ispisa kopija:
· grupiranje listova kopija u obliku knjige (npr. ako trebamo 5 kopija dokumenta od 10 stranica, ispisat će 5 puta sve stranice od 1 do 10 tako da su spremne za uvezivanje)
-to je uobičajeni način kod ispisa kopija
· negrupiranje listova kopija (svaku stranicu ispiše koliko nam treba kopija pa tako u prijašnjem primjeru redom dobivamo ispis 5 kopija stranice 1, potom 5 kopija stranice 2, itd.)
· umanjenje ispisa (koliko stranica dokumenta će biti ispisano na jednoj stranici papira)
· postavke stranice koje možemo i tu promijeniti prije ispisa (npr. veličina papira, usmjerenje, margine)
c) Zajednički koristi (engl. Share)
-ovo koristimo ako želimo olakšati da više osoba radi na istom dokumentu (npr. spremanjem u oblak)
d) Izvezi (engl. Export)
-biramo dodatne postavke formata za spremanje sadržaja (npr. XPS-a)
e) Korisnički račun (engl. Account)
-ovdje unosimo ključ proizvoda, aktiviramo Office i biramo način ažuriranja (npr. bez ažuriranja)
-ako program nema ispravan ključ ili nije aktiviran, radit će neko kraće vrijeme samo sa osnovnim mogućnostima, a onda prestati raditi
f) Povratne informacije (engl. Feedback)
-želimo li poboljšati iduću verziju Worda, možemo razvojnom timu poslati naše pohvale, primjedbe i prijedloge
g) Mogućnosti (engl. Options)
-ako želimo podesiti ponašanje Worda u skladu sa svojim željama, ovdje nam je na raspolaganju puno toga (npr. da li se ispisuje pozadina dokumenta)
[bookmark: _GoBack]1.5. Prikaz dokumenta
-prilikom unosa teksta unose se i neki znakovi koji u uobičajenom prikazu nisu vidljivi
-pomoću njih se npr. razdvajaju riječi, oblikuju odlomci i slično 
[image: ]-za prikaz tih znakova potrebno je kliknuti na odgovarajuću ikonu iz grupe Polazno>Odlomak
-naredba se zove Prikaži/Sakrij (engl. Show/Hide)
-uobičajeno ne prikazujemo nevidljive znakove, ali ponekad ih trebamo vidjeti (npr. da vidimo oznaku kraja sekcije)
-tri najčešća znaka oblikovanja su:
· razmak (pritisak na razmaknicu)
-prikazuje se znakom točkice ·
· početak i kraj odlomka (pritisak na tipku Enter)
-prikazuje se znakom  ¶
· tabulator (pritisak na tipku Tab)
-služi za stvaranje većeg razmaka u redu
[image: ]-prikazuje se znakom →
-program nudi nekoliko načina prikaza dokumenta klikom na Prikaz>Prikazi:
a) Način za čitanje (engl. Read Mode)
-ovakav prikaz olakšava nam čitanje gotovog dokumenta, ali nije pogodan za unos sadržaja
-da se olakša čitanje, ovaj način prikaza omogućava: 
· otvaranje navigacijskog okna (engl. Navigation Pane) za lakše snalaženje u tekstu
· prikaz komentara za pojašnjenje napisanoga
· mijenjanje širine stupca za lakše čitanje
· promjenu pozadine stranice (sepia, inverzno s crnom pozadinom) za manje umaranje očiju)
· prikazivanje u stupcima radi lakšeg praćenja teksta (mada originalni tekst nije u stupcima)
· rastavljanje riječi u slogove (npr. A . na . li . zi . ra . ti umjesto Analizirati) radi lakšeg čitanja za osobe s poteškoćama čitanja (npr. mala djeca, starci, disleksičari)
· promjenu proreda za olakšanje čitanja slično prijašnjoj mogućnosti
· čitanje označenoga teksta (podržava i hrvatski jezik) za slabovidne osobe
-iz ovoga prikaza izlazimo odabirom prve naredbe u stupcu (Uredi dokument, engl. Edit document)
b) Raspored za ispis (engl. Print Layout)
-ovo je uobičajen (i najbolji) način prikaza jer nam prikazuje točan izgled teksta, grafike i ostalih dijelova dokumenta (npr. margine, zaglavlja i sl.) kako će biti ispisani na papiru
-koristimo ga da bismo upisivali, uređivali i oblikovali tekst
[image: ]-osim samoga pisanja, ovaj prikaz koristan je za uređivanje dodatnih elemenata dokumenta (npr. zaglavlja i podnožja dokumenta, za podešavanje margina, kod rada sa stupcima teksta, pri unosu crteža i fotografija u tekst i sl.)

c) Raspored za web (engl. Web Layout)
-ovaj prikaz koristan je kod stvaranja web-stranica jer se cijeli tekst vidi na ekranu prikazan bez suvišnih grafičkih elemenata (npr. pozadine stranice) dok su ostali grafički objekti (npr. slike) prikazani drukčije smješteni
[image: ]-rijetko se koristi

d) Struktura (engl. Outline)
-koristimo ga kad želimo vidjeti strukturu (građu) dokumenta te za premještanje, kopiranje i reorganizaciju teksta povlačenjem naslova
[image: ]-ne koristi se često

e) Skica (engl. Draft)
-u njemu se prikazuje oblikovanje teksta, ali je pojednostavljeni prikaz stranica bez grafičkih objekata (npr. pozadine, slika, crteža)
[image: ]-vrlo rijetko se upotrebljava
[image: ][image: ]-na dnu dokumenta možemo brzo promijeniti način prikaza (Način za čitanje, Raspored za ispis, Raspored za web) odabirom odgovarajuće ikone
[image: ]-prikaz dokumenta na ekranu prilagođava se veličinom (povećava ili smanjuje) naredbama iz grupe  Prikaz>Zumiraj (engl. View>Zoom) te izborom iznosa povećanja u postocima (engl. Percent)
[image: ]-osim u postocima, dade se izabrati prikaz:
a) Jedna stranica (engl. One Page)
-stranica se prilagodi tako da je čitava vidljiva na ekranu
-nije preporučljivo za promjene u dokumentu (tekst je presitan za označavanje), ali se vide odnosi teksta i ostalih elemenata (npr. tablica i slika)
b) [image: ]Veći broj stranica (engl. Multiple Pages)
-vidi se nekoliko umanjenih stranica
-pogodno je za završno pregledavanje gotovoga dokumenta
c) Širina stranice (engl. Page Width)
[image: ]-stranica se tako prilagodi da se vidi cijela širina dokumenta, uključujući i margine
-uobičajeno se koristi za unos sadržaja jer je lakše označavanje zbog uvećanog prikaza teksta i objekata
[image: ]-opcije zumiranja možemo brže dobiti izborom ikone zumiranja u donjem desnom kutu dokumenta
[image: ][image: ]-ukoliko smo neku radnju krivo napravili u Wordu, možemo poništiti promjenu klikom lijevom tipkom na ikonu Poništi (engl. Undo) u traci za brzo pokretanje (strelica svinuta ulijevo) 
[image: ][image: ]-možemo poništiti i nekoliko zadnjih uzastopnih promjena (bez preskakanja pojedinih, dakle sve po redu) klikom na sitnu bijelu strelicu pokraj ikone poništi i odabirom naredbi koje želimo poništiti
-želimo li opozvanu promjenu ponovo vratiti, aktivirat ćemo ikonu Vrati poništeno (engl. Redo, strelica svinuta kružno ulijevo)
[image: ][image: ]-naredbe na traci za brzo pokretanje možemo birati, kao i mjesto njezina prikaza, klikom na sitni trokutić na njenom desnom kraju
-naredbe označene kvačicom vidljive su na traci, one bez nisu
-možemo birati i bilo koje naredbe klikom na Više naredbi… (engl. More commands) i odabirom željene naredbe iz neke grupe naredbi (isto kao i aktiviranjem naredbe Datoteka>Mogućnosti>Alatna traka za brzi pristup)
-traka za brzi pristup logično je smještena na početak naslovne trake dokumenta, ali se izborom naredbe Prikaži ispod vrpce (engl. Show under ribbon) može spustiti ispod otvorene vrpce s naredbama
[image: ]-time ništa ne dobivamo osim smanjenja područja za prikaz dokumenta pa je to neželjena mogućnost koju vraćamo natrag klikom na trokutić i naredbom Prikaži iznad vrpce (engl. Show over ribbon)
-na kartici Prikaz možemo prikazati ili isključiti:
a) Ravnalo (engl. Ruler)
[image: ]-uobičajeno je vidljivo, a koristimo ga da izmjerimo udaljenosti objekata i sl. (npr. izmjerimo širinu stupca tablice u mm ili cm)
b) [image: ]Crte rešetke (engl. Grid)
-ako nam je pozadina stranice jednobojna (npr. žuta), možemo vidjeti sitne kvadratiće (npr. kao u bilježnici iz matematike) koji nam mogu pomoći da lakše poravnamo pojedine objekte u dokumentu (npr. slike jednu ispod druge)
c) Navigacijsko okno (engl. Navigation pane)
-u ovom oknu s lijeve strane glavnog prozora možemo vidjeti rezultate pretraživanja teksta ili nekih drugih elemenata (npr. slika, jednadžbi) i brzo se kretati po označenim rezultatima
-traženi rezultati mogu se birati u:
· naslovima
· stranicama
· tekstu
-pronađeni rezultati se u tekstu u glavnom prozoru ističu markiranjem u žutu boju
[image: ]-ispiše nam se ukupni broj nađenih rezultata pa se strelicom gore ili dolje krećemo od jednog do drugog

-kada istodobno radimo sa dva ili više dokumenta možemo ubrzati rad prikazom otvorenih prozora u više prozora
-najčešće se koristi prikaz samo dva prozora jer su inače prozori premaleni za ugodan rad
-rad sa više prozora nam je koristan kada moramo istodobno vidjeti prikaz više dokumenata, različitih ili istih (npr. nešto moramo kopirati iz jednoga dokumenta s puno stranica i prebacivati u drugi i sl.)
-naredbe za rad s prozorima dostupne su odabirom grupe Prikaz>Prozor (engl. View>Window)
-možemo upotrijebiti ove naredbe:
a) [image: ]Novi prozor
-stvaramo novi prozor istoga dokumenta 
-svaki prozor dobiva posebnu oznaku, tj. redni broj prozora u naslovnoj traci (odmah iza nastavka datoteke odvojene dvotočkom, npr. docx:2)
b) Razmještaj svih elemenata
-ovime se prikažu svi otvoreni prozori jedan ispod drugoga pri čemu na graničnim horizontalnim linijama možemo definirati visinu svakoga od njih (povlačenjem dvostruke strelice za promjenu dimenzija prozora gore-dolje)
-ako neki prozor ne želimo vidjeti u razmještaju, spustimo ga gumbom za minimiziranje ili zatvorimo
[image: ]
c) Podjela
-isti dokument možemo prikazati u dva prozora jedan ispod drugoga pri čemu sadržaj u svakom od njih možemo neovisno pomicati
-ova naredba umeće granicu podjele dokumenta na dva prozora počevši od trenutnog položaja kursora
-u svakom prozoru vidljiv je sadržaj cijeloga dokumenta
[image: ]-kao i u prijašnjem slučaju, na graničnim horizontalnim linijama možemo definirati visinu svakoga od njih (povlačenjem dvostruke strelice za promjenu dimenzija prozora gore-dolje)
-ovo je korisna naredba kada radimo s većim brojem stranica u dokumentu (npr. sa stranice 3 moramo kopirati pojedine slike na stranicu 79) pa se ne moramo stalno kretati naprijed-natrag mišem i klizačima
d) Usporedni prikaz
[image: ]-kada smo razmjestili prozore naredbom Razmještaj svih elemenata, ovom možemo odrediti da li će ostati prikazani jedan ispod drugoga ili jedan pokraj drugoga
e) Sinkronizirano pomicanje
[image: ]-pri odabiru Usporednog prikaza odlučujemo da li ćemo sadržaj svakoga prozora pomicati zasebno ili će se pomicanjem jednoga na isti način pomicati sadržaj drugoga 
-pritom ne moramo biti na istom mjestu u oba prozora (npr. u prvom prozoru smo kursor postavili na 3. stranicu, a u drugom na 8.)
-ovo je korisno ako moramo negdje raditi pomake na sadržaju za određeni broj stranica
f) Vrati izvorni položaj prozora
-kada je uključen Usporedni prikaz, a pomicali smo sadržaj nekog od ta dva prozora, ovime položaj kursora u tom prozoru vraćamo na onaj u trenutku uključenja Usporednog prikaza
g) [image: ]Promjena prozora
-ovdje klikom biramo koji prozor je trenutno vidljiv (onaj s kvačicom)

[image: ][image: ]-na naslovnoj vrpci još možemo odabrati način prikaza aktivne kartice, vrpce i naredbi na njima klikom na simbol kvadratića sa strelicom prema gore pokraj gumba za minimiziranje prozora u gornjem lijevom kutu prozora 
-na raspolaganju su nam mogućnosti prikaza:
a) Automatski sakrij vrpcu (engl. Auto hide ribbon) 
-vrpca sa naredbama nije vidljiva dok mišem ne dođemo na sam vrh prozora i kliknemo lijevom tipkom na plavu vrpcu koja se pojavila
-ovakav prikaz koristan je ako nam je bitan čim veći dio prikazanoga sadržaja (npr. teksta), a ne ikone naredbi jer ćemo se koristiti mišem ili prečicama (npr. kod uređivanja teksta za kopiranje označenoga teksta koristimo prečicu Ctrl + C)
-za ostale operacije bitan nam je prikaz ikona naredbi pa nam je ovakav prikaz nepraktičan
[image: ]-isključujemo ga ponovnim klikom na ikonu kvadratića sa strelicom i odabirom drugih opcija
b) Pokaži kartice (engl. Show tabs)
-ovdje je vidljiva samo uska traka s prikazom kartica, a vrpcu s naredbama vidimo tek kada kliknemo karticu
-ovo je kompromis između prve i zadnje mogućnosti prikaza pa dobivamo veći dio radnog područja, a naredbe se mogu lako prikazati
[image: ]-ipak, za ozbiljniji rad s općim sadržajem je nepraktično
c) Pokaži kartice i naredbe (engl. Show tabs and commands)
[image: ]-ovo je standardna postavka gdje vidimo sve kartice i naredbe u vrpci, ali nam je radno područje najmanje
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grafikoni i SmartArt grafika promijenit ¢e se u

skladu s novom temom, Kada primijenite stilove, naslovi ¢e se promijeniti u skladu 5 novom temaom.
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pretraZivati na internetu za videozapis koji najbolje odgovara vasem dokumentu. Da bi dokument
izgledao profesionalno, Word nudi dizajne zaglavlja, podnoZja, naslovne stranice i tekstnog okvira koji
se medusobno nadopunjavaju. Na primjer, moZete dodati odgovarajuéu naslovnu stranicu, zaglavlje i
bocnu traku.
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izgledao profesionalno, Word nudi dizajne zaglavlja, podnoZja, naslov
se medusobno nadopunjavaju. Na primjer, moZete dodati odgovarajt
bocnu traku.

Kliknite Umetanje, a zatim odaberite Zeljene elemente iz razli¢itih gal:
da dokument ostane uskladen. Kada kliknete Dizajn i odaberete novu
grafika promijenit ¢e se u skladu s novom temom. Kada primijenite st
skladu s novom temom. Ustedite vrijeme u programu Word pomodu |
kada su vam potrebni.

Da biste promijenili nadin na koji se slika uklapa u dokument, kliknite
gumb za mogucénosti izgleda. Tijekom rada na tablici kliknite na mjest

stupac, a zatim kliknite znak plus. | ¢itanje je jednostavnije u novom p

dijelove dokumenata i usredotoditi se na Zeljeni tekst. Ako morate pr
do kraja, Word pamti gdje ste stali, éak i na drugom uredaju.
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Videozapis je udinkovit nacin da argumentirate svoje stajaliste. Kad ki
moZete zalijepiti ugradeni kod za videozapis koji Zelite dodati. MoZete¢
pretraZivati na internetu za videozapis koji najbolje odgovara vasem ¢
izgledao profesionalno, Word nudi dizajne zaglavlja, podnoZja, naslov
se medusobno nadopunjavaju. Na primjer, moZete dodati odgovarajt
bocnu traku.

Kliknite Umetanje, a zatim odaberite Zeljene elemente iz razli¢itih gal:
da dokument ostane uskladen. Kada kliknete Dizajn i odaberete novu
grafika promijenit ¢e se u skladu s novom temom. Kada primijenite st
skladu s novom temom. Ustedite vrijeme u programu Word pomodu |
kada su vam potrebni.
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f2 Automatski sakrij vrpeu
Saksijte vrpeu. Kiiknite pri vihu
aplikacije da biste je prikazali.
f==— Pokazi kartice
Prikatite samo kartice vrpce. Kliknite
karticu da biste prikazali naredbe.
Pokazi kartice i naredbe
Prikazujte kartice vrpce i naredbe
cijelo vrijeme.
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